


    

 
 

 

USER’S GUIDE FOR ESTIMATING 
CARBON DIOXIDE, NITROUS 
OXIDE, HFC, PFC, AND SF6 
EMISSIONS FROM INDUSTRIAL 
PROCESSES USING THE STATE 
INVENTORY TOOL 
 

 

JANUARY 2017 
 

 
 
 
 
Prepared by: 
ICF 

Prepared for: 
State Climate and Energy Program,  
U.S. Environmental Protection Agency 

This section of the User’s Guide provides instruction on using the Industrial Processes (IP) 
module of the State Inventory Tool (SIT), and describes the methodology used for 
estimating carbon dioxide (CO2), nitrous oxide (N2O), HFC, PFC, and SF6 emissions from 
industrial processes at the state level.   
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1.1 GETTING STARTED 

The Industrial Processes (IP) module of the State Inventory Tool (SIT) was developed using 
Microsoft® Excel 2000.  While the module will operate with older versions of Excel, it 
functions best with Excel 2000 or later. If you are using Excel 2007, instructions for opening 
the module will vary as outlined in the instructions below. Some of the Excel basics are 
outlined in the sections below.  Before you use the IP module, make sure your computer 
meets the system requirements.  In order to install and run the IP module, you must have: 

 IBM-PC compatible computer with the Windows 95 operating system or later; 

 Microsoft® Excel 1997 or later, with calculation set to automatic and macros 
enabled; 

 Hard drive with at least 20MB free; and 

 Monitor display setting of 800 x 600 or greater. 

Microsoft Excel Settings 

Excel 2003 and Earlier: For the SIT modules to function properly, Excel must be set to 
automatic calculation.  To check this setting, launch Microsoft Excel before opening the IP 
module.  Go to the Tools menu and select “Options...” Click on the “Calculations” tab and 
make sure that the radio button next to “Automatic” is selected, and then click on “OK” to 
close the window.  The security settings (discussed next) can also be adjusted at this time. 

Excel 2007: For the SIT modules to function properly, Excel must be set to automatic 
calculation.  Go to the Formulas ribbon and select “Calculation Options.” Make sure that the 
box next to the “Automatic” option is checked from the pop-up menu.   

Microsoft Excel Security 

Excel 2003 and Earlier: Since the SIT employs macros, you must have Excel security set 
to medium (recommended) or low (not recommended).  To change this setting, launch 
Microsoft Excel before opening the IP module.  Once in Excel, go to the Tools menu, click on 
the Macro sub-menu, and then select “Security” (see Figure 1).  The Security pop-up box 
will appear.  Click on the “Security Level” tab and select medium.  When set to high, macros 
are automatically disabled; when set to medium, Excel will give you the choice to enable 
macros; when set to low, macros are always enabled. 

When Excel security is set to medium, users are asked upon opening the module whether to 
enable macros.  Macros must be enabled in order for the IP module to work.  Once they are 
enabled, the module will open to the control worksheet.  A message box will appear 
welcoming the user to the module.  Clicking on the “x” in the upper-right-hand corner of the 
message box will close it. 

Excel 2007: If Excel’s security settings are set at the default level a Security Warning 
appears above the formula box in Excel when the IP module is initially opened. The Security 
Warning lets the user know that some active content from the spreadsheet has been 
disabled, meaning that Excel has prevented the macros in the spreadsheet from functioning.  
Since SIT needs macros in order to function properly, the user must click the “Options” 
button in the security message and then select, “Enable this content” in the pop-up box. 
Enabling the macro content for the SIT in this way only enables macros temporarily in Excel 
but does not change the macro security settings.  Once macros are enabled, a message box 
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will appear welcoming the user to module.  Click on the “x” in the upper right-hand corner 
to close the message box. 

If the Security Warning does not appear when the module is first opened, it may be 
necessary to change the security settings for macros.  To change the setting, first exit out 
of the IP module and re-launch Microsoft Excel before opening the IP module.  Next, click on 
the Microsoft Excel icon in the top left of the screen. Scroll to the bottom of the menu and 
select the “Excel Options” button to the right of the main menu. When the Excel Options box 
appears, select “Trust Center” in left hand menu of the box.  Next, click the gray “Trust 
Center Settings” button.  When the Trust Center options box appears, click “Macro Settings” 
in the left hand menu and select “Disable all macros with notification.”  Once the security 
level has been adjusted, open the IP module and enable macros in the manner described in 
the preceding paragraph. 

Viewing and Printing Data and Results 

The IP module contains some features to allow users to adjust the screen view and the 
appearance of the worksheets when they are printed.  Once a module has been opened, you 
can adjust the zoom by going to the Module Options Menu, and either typing in a zoom 
percentage or selecting one from the drop down menu.  In addition, data may not all appear 
on a single screen within each worksheet; if not, you may need to scroll up or down to view 
additional information. 

You may also adjust the print margins of the worksheets to ensure that desired portions of 
the IP module are printed.  To do so, go to the File menu, and then select “Print Preview.”  
Click on “Page Break Preview” and drag the blue lines to the desired positions (see Figure 
2).  To print this view, go to the File menu, and click “Print.”  To return to the normal view, 
go to the File menu, click “Print Preview,” and then click “Normal View.” 

Figure 1.  Changing Security Settings 

 
 

Figure 2.  Adjusting Print Margins 

 

1.2 MODULE OVERVIEW 

This User’s Guide accompanies and explains the Industrial Processes module of the SIT.  
The SIT was developed in conjunction with EPA’s Emissions Inventory Improvement 
Program (EIIP).  Prior to the development of the SIT, EPA developed the States Workbook 
for estimating greenhouse gas emissions.  In 1998, EPA revisited the States Workbook and 

Drag cursor 
to resize page 
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expanded it to follow the format of EIIP guidance documents for criteria air pollutants.  The 
result was a comprehensive, stepwise approach to estimating greenhouse gas emissions at 
the state level.  This detailed methodology was appreciated by states with the capacity to 
devote considerable time and resources to the development of emission inventories.  For 
other states, the EIIP guidance was overwhelming and impractical for them to follow from 
scratch.  EPA recognized the resource constraints facing the states and developed the SIT.  
The ten modules of the SIT corresponded to the EIIP chapters and attempted to automate 
the steps states would need to take in developing their own emission estimates in a manner 
that was consistent with prevailing national and state guidelines.   

Since most state inventories developed today rely heavily on the tools, User’s Guides have 
been developed for each of the SIT modules.  These User’s Guides contain the most up-to-
date methodologies that are, for the most part, consistent with the Inventory of U.S. 
Greenhouse Gas Emissions and Sinks.  Volume VIII of the EIIP guidance is a historical 
document that was last updated in August 2004, and while these documents can be a 
valuable reference, they contain outdated emissions factors and in some cases outdated 
methodologies.  States can refer to Volume VIII of the EIIP guidance documents if they are 
interested in obtaining additional information not found in the SIT or the companion User’s 
Guide. 

The IP module calculates carbon dioxide (CO2), nitrous oxide (N2O), hydrofluorocarbon 
(HFC), perfluorocarbon (PFC), and sulfur hexafluoride (SF6) emissions from the IP sectors 
shown in Table 1.  While the module provides default data for each sector (depending on 
availability), if you have access to a more comprehensive data source, it should be used in 
place of the default data.  If using outside data sources, or for a more thorough 
understanding of the tool, please refer to the following discussion for data requirements and 
methodology. 

1.2.1 Data Requirements 

To calculate CO2, N2O, and HFC, PFC, and SF6 emissions from IP, general activity data on 
various IP sectors are required.  A complete list of the activity data and emission factors 
necessary to run the IP module is provided in Table 1.   
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Table 1.  IP Sectors, Data Requirements, and Gases Emitted 
Module Worksheet Data Required Gas(es)  
Cement Production Emission factors and production data for 

clinker and cement kiln dust (CKD) 
 

CO2 

Lime Manufacture Emission factors and production data for 
high-calcium lime, and dolomitic lime 
 

Limestone and Dolomite Use Emission factors and consumption data 
for limestone, dolomite, and magnesium 
produced from dolomite 

Soda Ash Manufacture and Consumption Emission factors and consumption data 
for manufacture and consumption of 
soda ash 

Iron and Steel Production Emission factors and production data for 
Basic Oxygen Furnace (BOF) at 
Integrated Mill with Coke Ovens, Basic 
Oxygen Furnace (BOF) at Integrated Mill 
without Coke Ovens, Electric Arc Furnace 
(EAF), and Open Hearth Furnace (OHF) 

Ammonia Manufacture Emission factors and production and 
consumption data for ammonia 
production, and urea consumption 

Nitric Acid Production Emission factor, production data, and 
Percent N2O Released after Pollution 
Control for nitric acid production N2O Adipic Acid Production Emission factor, production data, and 
Percent N2O Released after Pollution 
Control for adipic acid production 

Aluminum Production Emission factor and production data for 
aluminum production 

HFC, PFC and 
SF6 

HCFC-22 Production Emission factor and production data for 
HCFC-22 production 

Consumption of Substitutes for Ozone-
Depleting Substances (ODS) 

No input data required* 

Semiconductor Manufacture No input data required* 

Electric Power Transmission and 
Distribution 

Emission factor and SF6 consumption 
data for electric power transmission and 
distribution 

Magnesium Production and Processing Emission factor and consumption data 
for primary production, secondary 
production, and casting 

*According to the most recent inventory guidance, emissions of HFCs, PFCs, and SF6 from ODS 
substitutes and semiconductor production can be estimated by apportioning national emissions to 
each state based on population.  Because this tool apportions national emissions based on state 
population, the emission factors and activity data for these sources are not required. 

1.2.2 Tool Layout 

Since there are multiple steps to complete within the IP module, it is important to have an 
understanding of the module’s overall design.  The layout of the IP module is presented in 
Figure 3.   
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Figure 3.  Flow of Information in the IP Module* 

 
* According to the most recent inventory guidance, emissions of HFCs, PFCs, and SF6 from ODS 
substitutes and semiconductor production can be estimated by apportioning national emissions to 
each state based on population.  Because this tool apportions national emissions based on state 
population, no emission factors need to be entered for these sources. 
 
1.3 METHODOLOGY 

This section provides a guide to using the IP module of the SIT to estimate CO2, N2O, and 
HFC, PFC, and SF6 emissions from IP.  The sectors included in the IP module are cement 
production, lime manufacture, limestone and dolomite use, soda ash manufacture and 
consumption, iron and steel production, ammonia manufacture, nitric and adipic acid 
production, aluminum production, HCFC-22 production, consumption of substitutes for 
ozone depleting substances, semiconductor manufacture, electric power transmission and 
distribution, and magnesium production and processing.  Since the methodology varies by 
sector, they are discussed separately and specific examples for each sector are provided. 

The IP module follows the general methodology outlined in Chapter 6 of the Emissions 
Inventory Improvement Program (EIIP) guidance, however because of the automation of 
the calculations within the tool, the order of steps discussed in this guide do not always 
follow the order of steps discussed within the EIIP guidance document.   

This User’s Guide provides an overview of the estimation methodology used in the IP 
module by walking through the following steps: (1) select a state; (2) enter available data 
aggregated for EPA’s Greenhouse Gas Reporting Rule; (3) enter emission factors and 
activity data for cement production; (4) enter emission factors and activity data for lime 
manufacture; (5) enter emission factors and activity data for limestone and dolomite use; 
(6) enter emission factors and activity data for soda ash manufacture and consumption; (7) 
enter emission factors and activity data for iron and steel production; (8) enter emission 
factors and activity data for ammonia manufacture; (9) enter emission factors and activity 
data for nitric acid production; (10) enter emission factors and activity data for adipic acid 
production; (11) enter emission factors and activity data for aluminum production; (12) 
enter emission factors and activity data for HCFC-22 production; (13) review sector 
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worksheet for consumption of substitutes for ozone depleting substances; (14) review 
sector worksheet for semiconductor manufacture; (15) enter emission factors and activity 
data for electric power transmission and distribution; (16) complete control and sector 
worksheets for magnesium production and processing; (17) review summary information; 
and (18) export data.  The general equations used to calculate CO2, N2O, and HFC, PFC, and 
SF6 emissions from IP are shown in the discussion of each specific sector. 

Step (1) Select a State  

To begin, select the state you are interested in evaluating.  By selecting a state, the rest of 
the tool will automatically reset to reflect the appropriate state default data and 
assumptions for use in subsequent steps of the tool.   

Step (2) Enter Emission Estimates for Facilities Reporting to EPA’s Greenhouse 
Gas Reporting Rule  

Beginning in 2010, many facilities were required to monitor, calculate and report their 
greenhouse gas emissions to EPA through its Greenhouse Gas Reporting Program (GHGRP). 
Under the program, EPA obtained data for 2010 emissions from facilities based on use of 
higher tier methods. For some of the source categories, all of the facilities that have that 
particular source category within their boundaries will be subject to the rule. For these 
facilities, EPA’s analysis indicated that all or nearly all facilities within that source category 
emit more than 25,000 mtCO2e per year, and that an “all in” would simplify their 
applicability determination. The sources included in the IP module that have been 
determined “all in” under the rule are listed on the Greenhouse Gas Reporting Rule 
worksheet. If available, the data entered in the yellow cells of this worksheet should 
represent the total state emissions for the source categories beginning in 2010 (e.g., the 
reported facility data should be summed). 

To obtain GHGRP data for your state: 

1) Go to http://ghgdata.epa.gov/ghgp/main.do 

2) Select your state 

3) At the bottom of the webpage (under the map), only check chemicals, metals, and 
minerals sectors. 

4) Within each of these categories, hover over the gear to the right for each, and only 
check the industries that apply below. 

5) Select "APPLY" 

6) View applicable facilities and emissions for your state, and record the estimates in 
the yellow cells on the Greenhouse Gas Reporting Rule data input worksheet. 

Step (3) Enter Emission Factors and Activity Data for Cement Production 

Control Worksheet 

The second step for the control worksheet is to either select the default data provided or to 
enter user-specified data that will be used throughout the tool.  To proceed with the default 
data, select the “Clear/Select All” button for each sector on the control worksheet or check 
the individual default box directly to the right of specific yellow input cells.  See Figure 4 for 
locations of the “Clear/Select All” buttons, individual default check boxes, and yellow input 
cells.  Note that this number can be overwritten if you later discover that the data for your 
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state differ from the default data provided by the tool.  To enter user-specified inputs, enter 
data directly into the yellow input cells.  If the user-specific inputs do not match the default 
data in the control worksheet (i.e., the default value is overwritten), the text will appear 
red.  Information requirements on the control worksheet for each sector are discussed 
separately below. 

Figure 4.  Control Worksheet for the IP Module 

  
 

The first type of required data in the control worksheet is emission factors for clinker, and 
cement kiln dust used in cement production.  CO2 emissions from cement production consist 
of emissions produced during the cement clinker production processes, and are in units of 
metric tons of CO2 released per metric ton of clinker or cement kiln dust produced. 
Emissions from the production of masonry cement are accounted for in Lime emissions 
estimates. 

Cement Production Sector Worksheet 

The activity data required to populate the blue cells in the cement production worksheet are 
metric tons of clinker produced annually, as shown in Figure 5. Select “Check All Boxes” if 
you would like to use default data provided in the IP module.  Activity data for cement 
production by state is available from USGS 2013e. CO2 is created when calcium carbonate 
(CaCO3) is heated in a cement kiln to form lime (calcium oxide or CaO) and CO2. This 
process is known as calcination or calcining. 

Cement clinker emissions are calculated by multiplying the clinker production quantity by 
the emission factor entered on the control worksheet, and adding the product to the 
emissions from cement kiln dust (a by-product of cement clinker production). The emissions 
are then converted from metric tons of carbon equivalents (MTCE) to metric tons of carbon 
dioxide equivalents (MTCO2E).  Equation 1 shows this calculation for CO2 emissions from 
cement production. 

Required Data 
Input Cells 

Select All Defaults 

Individual Default 
Data Check Boxes 
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Equation 1.  Emission Equation for Cement Production 

 

Figure 5.  Example of Activity Data Applied in the Cement Production Worksheet 

 
 

 

Step (4) Enter Emission Factors and Activity Data for Lime Manufacture 

Control Worksheet 

The emission factors for high-calcium lime and dolomitic lime manufacture are the next 
required inputs on the control worksheet.  Lime is manufactured by heating limestone 
(mostly CaCO3) in a kiln, creating CaO and CO2.  The IP module estimates these CO2 
emissions from two types of lime: high-calcium lime and dolomitic lime production.  

Lime Manufacture Sector Worksheet 

Production data for high-calcium dolomite and dolomitic lime, and the amount of these used 
in sugar refining and precipitated calcium carbonate are required inputs in the blue cells of 
the lime manufacture worksheet as shown in Figure 6.  Activity data for lime manufacture 
by state is available from USGS 2015a. 

Before entering the production of high-calcium and dolomitic lime, you must correct for the 
water content of hydrated lime.  The water content can be assumed to be 24.3 percent for 
high-calcium hydrated lime and 27.3 percent for dolomitic lime.  To correct for the water 
content of hydrated lime, multiply the production data for high-calcium hydrated lime and 
dolomitic hydrated lime by their respective percentages of dry lime to find the corrected 

Emissions (MTCO2E) =  
Production (metric tons) × Emission Factor (t CO2/t production) + Emissions 

from Cement Kiln Dust (Metric tons CO2)  

Select All Defaults 

Emission Factors 

Required Data 
Input Cells 
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production numbers for both varieties of hydrated lime.  An example of this correction for 
high-calcium lime is shown in Equation 2. 

Equation 2.  Example Calculation for Hydrated Lime Correction 

 

To calculate emissions from this source, the production quantity of each lime type is 
multiplied by its respective emission factor from the control worksheet.  Because lime used 
in sugar refining and precipitated calcium carbonate production results in the reabsorbtion 
of atmospheric CO2, carbon absorbed from these uses is subtracted from gross emissions.  
The emissions are then converted from metric tons of carbon equivalents (MTCE) to metric 
tons of carbon dioxide equivalents (MTCO2E).  Equation 3 shows this calculation for CO2 
emissions from cement production.  

Equation 3.  Emission Equation for Lime Manufacture 

 
Figure 6.  Example of Activity Data Applied in the Lime Manufacture Worksheet 

 
Step (5) Enter Emission Factors and Activity Data for Limestone and Dolomite 

Use 

Control Worksheet 

The next inputs on the control worksheet are emission factors for limestone and dolomite 
use, and magnesium produced from dolomite.  Limestone (CaCO3) and dolomite 
(CaMg(CO3)2) are basic raw materials used by a wide variety of industries, including the 

Corrected Lime Content of High-Calcium Hydrated Lime (metric tons) = 
High-Calcium Hydrated Lime Production (metric tons) x (1 – 0.24 metric tons water/metric 

ton high-calcium hydrated lime) 
 

Emissions (MTCO2E) = [Production (metric tons) - Sugar Refining and Precipitated Calcium 
Carbonate Production (metric tons) × CO2 Reabsorbtion Factor (80%)] × Emission Factor 

(MT CO2/MT production)  

Required Data 
Input Cells 
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construction, agriculture, chemical, glass manufacturing, environmental pollution control, 
and metallurgical industries such as magnesium (Mg) production.  

Limestone and Dolomite Use Sector Worksheet 

Production data for limestone and dolomite use, and magnesium production from dolomite 
are required as inputs in the blue cells of the limestone and dolomite worksheet as 
displayed in Figure 7.  As an example, CO2 is emitted as a by-product from the reaction of 
limestone or dolomite with impurities in the iron ore and fuels heated in a blast furnace.  
Activity data for limestone and dolomite use by state is available from USGS 2015b. 

The quantities of limestone consumed for industrial purposes, dolomite consumed for 
industrial purposes, and magnesium produced from dolomite are multiplied by their 
respective emission factors.  The emissions are then converted from metric tons of carbon 
equivalents (MTCE) to metric tons of carbon dioxide equivalents (MTCO2E).  For default 
data, each state's total limestone consumption (as reported by USGS) is multiplied by the 
ratio of national limestone consumption for industrial uses to total National limestone 
consumption.  Equation 4 shows this calculation for CO2 emissions from limestone and 
dolomite use.  

Equation 4.  Emission Equation for Limestone and Dolomite Use 

 
 

Figure 7.  Example of Activity Data Applied in the Limestone and Dolomite Use 
Worksheet 

 

Step (6) Enter Emission Factors and Activity Data for Soda Ash Manufacture 
and Consumption 

Control Worksheet 

Emissions (MTCO2E) =  
Consumption (metric tons) × Emission Factor (MT CO2/MT production)  

Required Data 
Input Cells 
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Soda ash manufacture and consumption emission factors are required inputs on the control 
worksheet in order to calculate emissions from this source.  Although only three states 
produced soda ash at the time of publication (Wyoming, California, and Colorado), all states 
consumed it.  Thus, all states should estimate CO2 emissions from soda ash consumption. 

Soda Ash Manufacture and Consumption Sector Worksheet 

Production data for the manufacture and consumption of soda ash are required as inputs in 
the blue cells of the soda ash manufacture worksheet as shown in Figure 8.  Under the soda 
ash production method used in some states, trona (an ore from which natural soda ash is 
made) is calcined in a rotary kiln and chemically transformed into a crude soda ash that 
requires further processing.  CO2 and water are generated as a by-product of the calcination 
process.  CO2 is also released when soda ash is consumed in products such as glass, soap, 
and detergents.  Activity data for soda ash manufacture and consumption by state is 
available from USGS 2015c. 

Emissions from soda ash manufacture and consumption are calculated by multiplying the 
quantity of soda ash manufactured (Wyoming only) and the quantity of soda ash consumed 
by their respective emission factors.  The emissions are then converted from metric tons of 
carbon equivalents (MTCE) to metric tons of carbon dioxide equivalents (MTCO2E) as shown 
in Equation 5.   

Equation 5.  Emission Equation for Soda Ash Manufacture and Consumption 

 

Figure 8.  Example of Activity Data Applied in the Soda Ash Manufacture and 
Consumption Worksheet 

 

 

Emissions (MTCO2E) =  
Manufacture/Consumption (metric tons) × Emission Factor (MT CO2/MT 

production) 
 

Required Data 
Input Cells 
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Step (7) Enter Emission Factors and Activity Data for Iron and Steel 
Production 

Control Worksheet 

Emission factors for the following iron and steel production processes are required as inputs 
on the control worksheet: Basic Oxygen Furnace (BOF) at Integrated Mill with Coke Ovens, 
Basic Oxygen Furnace (BOF) at Integrated Mill without Coke Ovens, Electric Arc Furnace 
(EAF), and open hearth furnace (OHF).  In addition to being an energy intensive process, 
the production of iron and steel also generates process-related emissions of CO2.  It is 
strongly advised that users enter state-specific information, as default data are based on 
national averages and are not available for all years. 

Iron and Steel Production Sector Worksheet 

Activity data for the production of iron and steel are required as inputs in the blue cells of 
the iron and steel worksheet displayed in Figure 9.  The basic activity data needed are the 
quantities of crude steel produced (defined as first cast product suitable for sale or further 
processing) by production method.  It is strongly advised that users enter state-specific 
information, as default data are based on national averages, are not available for all years, 
and are likely to be inaccurate for states.  The national data are provided by the American 
Iron and Steel (AISI) Annual Statistics Report 2009 (AISI 2011). 

Emissions from iron and steel production are based on the state-level production data 
assigned to production method based on the national distribution of production by method.  
The emissions are then converted from metric tons of carbon equivalents (MTCE) to metric 
tons of carbon dioxide equivalents (MTCO2E) as shown in Equation 6.   

Equation 6.  Emission Equation for Iron and Steel Production 

 

Figure 9.  Example of Activity Data Applied in the Iron and Steel Production 
Worksheet 

 

Emissions (MTCO2E) =  
Manufacture/Consumption (metric tons) × Emission Factor (MT CO2/MT production)  

Required Data 
Input Cells 
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Step (8) Enter Emission Factors and Activity Data for Ammonia Manufacture 

Control Worksheet 

The emission factors for ammonia and urea production are the next required inputs on the 
control worksheet.  Emissions of CO2 occur during the production of synthetic ammonia, 
primarily through the use of natural gas as a feedstock.   

Ammonia Manufacture Sector Worksheet 

Data for the production of ammonia and consumption of urea are required inputs in the blue 
cells on the ammonia production worksheet, shown in Figure 10.  Activity data for ammonia 
manufacture by state is available from USGS 2015f.  Activity data for urea consumption by 
state is estimated based on state data from AAPFCO (2014) and TVA (1991 through 1994).  

Emissions from ammonia production and urea consumption are calculated by multiplying the 
quantity of ammonia produced and urea applied by their respective emission factors.  
Emissions from urea consumption are subtracted from emissions due to ammonia 
production.  The emissions are then converted from metric tons of carbon equivalents 
(MTCE) to metric tons of carbon dioxide equivalents (MTCO2E) as shown in Equation 7 and 
Equation 8. 

Equation 7.  Emission Equation for Ammonia Production 

 

Equation 8.  Emission Equation for Urea Consumption 

 

Emissions (MTCO2E) =  
Consumption of Urea (metric tons) × Emission Factor (MT CO2/MT activity) 

Emissions (MTCO2E) =  
Production of Ammonia (metric tons) × Emission Factor (MT CO2/MT 

activity) - Emissions from Urea (MTCO2E) 
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Figure 10.  Example of Activity Data Applied in the Ammonia Production and Urea 
Consumption Worksheet 

 

Step (9) Enter Emission Factors and Activity Data for Nitric Acid Production 

Control Worksheet 

The emission factor for nitric acid production is the next required input for the control 
worksheet.  The production of nitric acid (HNO3) produces N2O as a by-product, via the 
oxidation of ammonia.  Nitric acid is a raw material used primarily to make synthetic 
commercial fertilizer and is also a major component in the production of adipic acid (a 
feedstock for nylon) and explosives.  

Nitric Acid Production 

Data for the amount of nitric acid produced, as well as the percent N2O released after 
pollution control are inputs for the nitric acid worksheet as seen in Figure 11.  Activity data 
for nitric acid production is available from SRI 2000.  The production of nitric acid (HNO3) 
produces N2O as a by-product, via the oxidation of ammonia.  During this reaction, N2O is 
formed as a by-product and is released from reactor vents into the atmosphere.  At present, 
the nitric industry controls for oxides of nitrogen through two technologies: non-selective 
catalytic reduction (NSCR) and selective catalytic reduction (SCR).  Only one of these 
technologies, NSCR, is effective at destroying N2O emissions in the process of destroying 
NOx emissions. 

Emissions from nitric acid production are calculated by multiplying the quantity of nitric acid 
produced by an emission factor and by the percentage of N2O released after pollution 
controls are taken into account.  These emissions are then converted from metric tons of 
carbon equivalents (MTCE) to metric tons of carbon dioxide equivalents (MTCO2E) as seen in 
Equation 9. 

Required Data 
Input Cells 
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Equation 9.  Emission Equation for Nitric Acid Production 

 

Figure 11.  Example of Activity Data Applied in the Nitric Acid Production 
Worksheet 

 

Step (10) Enter Emission Factors and Activity Data for Adipic Acid Production 

Control Worksheet 

The emission factor for adipic acid production is required next on the control worksheet.  
About 90 percent of all adipic acid produced in the United States is used in the production of 
nylon 6,6, as well as production of some low-temperature lubricants.  It is also used to 
provide foods with a “tangy” flavor.  

Adipic Acid Production Sector Worksheet 

Data for the amount of adipic acid produced, as well as the percent N2O released after 
pollution control are inputs for the adipic acid worksheet as seen in Figure 12.  A dialogue 
box will appear if adipic acid is not produced in your state.  Note that plants may consider 
this data confidential and could be reluctant to disclose it, in which case, states should use 
the adipic acid production capacity data in the Chemical Market Reporter. 

Adipic acid is produced through a two-stage process.  The first stage involves the oxidation 
of cyclohexane to form a cyclohexanone/cyclohexanol mixture.  The second stage involves 
the oxidation of ketone-alcohol with nitric acid.  N2O is generated as a by-product of this 
reaction and enters the waste gas stream.  In the United States, this waste gas is treated to 
remove NOx and other regulated pollutants (and, in some cases, N2O as well) and is then 
released into the atmosphere. 

Emissions (MTCO2E) =  
Production of Nitric Acid (metric tons) × Emission Factor (MT N2O/MT production) x 

Percent N2O Released after Pollution Control x GWP N2O  

Required Data 
Input Cells 



Module 6 –Industrial Processes Module           January 2017 

State Greenhouse Gas Inventory Tool User’s Guide for the IP Module                   1.17 

Emissions from adipic acid production are calculated by multiplying the quantity adipic acid 
produced by an emission factor and by the percentage of N2O released after pollution 
controls are taken into account.  These emissions are then converted from metric tons of 
N2O to metric tons of carbon equivalents (MTCE) and then metric tons of carbon dioxide 
equivalents (MTCO2E), shown in Equation 10. 

Equation 10.  Emission Equation for Adipic Acid Production 

 
 
 

Figure 12.  Example of Activity Data Applied in the Adipic Acid Production 
Worksheet 

 
 

Step (11) Enter Emission Factors and Activity Data for Aluminum Production 

Control Worksheet 

The emission factor for aluminum production is the next input on the control worksheet.  
The aluminum production industry is thought to be the largest source of two PFCs – 
tetrafluoromethane (CF4) and hexafluoroethane (C2F6).  Emissions of these two potent 
greenhouse gases (GHGs) occur during the reduction of alumina in the primary smelting 
process.1  

                                          

1 Perfluorinated carbons are not emitted during the smelting of recycled aluminum. 

Emissions (MTCO2E) =  
Production of Adipic Acid (metric tons) × Emission Factor (MT N2O/MT 
production) x Percent N2O Released after Pollution Control x GWP N2O 

 

Required Data 
Input Cells 
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Aluminum Production Sector Worksheet 

Data for the production of aluminum are required in the blue cells of the aluminum 
worksheet, shown in Figure 13.  Activity data for aluminum production is available from 
USGS 2015d.   

The aluminum production industry is thought to be the largest source of two 
perfluorocarbons (PFCs) – tetrafluoromethane (CF4) and hexafluoroethane (C2F6).  
Emissions of these two potent GHGs occur during the reduction of alumina in the primary 
smelting process.1 

Emissions from aluminum production are calculated by multiplying the quantity of aluminum 
produced during a year by the specific emission factor for that year.  These emissions are 
then converted from metric tons of carbon equivalents (MTCE) to metric tons of carbon 
dioxide equivalents (MTCO2E), shown in Equation 11. 

Equation 11.  Emission Equation for Aluminum Production 

 
 

Figure 13.  Example of Activity Data Applied in the Aluminum Production 
Worksheet 

 

Step (12) Enter Emission Factors and Activity Data for HCFC-22 Production  

Control Worksheet 

The next emission factor required for the control worksheet is for HFC-23 emissions 
resulting from HCFC-22 production, in metric tons of HFC-23 emitted per metric ton of 
HCFC-22 produced.   

Emissions (MTCO2E) =  
Production of Aluminum (metric tons) × Emission Factor (MT CE/MT 

production) 

Required Data 
Input Cells 
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HCFC-22 Production Sector Worksheet 

HFC-23, one type of HFC, is known to be emitted in significant quantities as a by-product of 
HCFC-22 production.  Data for the production of HCFC-22 are required inputs in the blue 
cells on the HCFC-22 production worksheet, shown in Figure 14.  In order to obtain activity 
data, in-state manufacturers of HCFC-22 should be consulted first.  Additionally the 
Chemical Manufacturers Association (Washington, D.C.), Alliance for Responsible CFC Policy 
(Arlington, VA), and Grant Thorton Consulting (Washington, D.C.) can be contacted for 
information on state-by-state production numbers. 

Emissions from HCFC-22 production are calculated by multiplying the quantity of HCFC-22 
produced by an emission factor.  The emissions are then converted from metric tons of 
HFC-23 to metric tons of carbon equivalents (MTCE) and then metric tons of carbon dioxide 
equivalents (MTCO2E) as in Equation 12. 

Equation 12.  Emission Equation for HCFC-22 Production 

 
 

Figure 14.  Example of Activity Data Applied in the HCFC-22 Production Worksheet 

 

Step (13) Review Sector Worksheet for Consumption of Substitutes for Ozone-
Depleting Substances (ODS) 

Control Worksheet 

There are no emission factor inputs required for the consumption of substitutes for ozone-
depleting substances (ODS) as the calculations for this sector are performed on the sector-
specific worksheet.  Hydrofluorocarbons (HFCs) are used primarily as alternatives to several 

Emissions (MTCO2E) =  
Production of HCFC-22 (metric tons) × Emission Factor (MT HFC-23/MT 

production) x GWP of HFC-23 

Required Data 
Input Cells 
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classes of ODS that are being phased out under the terms of the Montreal Protocol and the 
Clean Air Act Amendments of 1990.  ODSs, which include chlorofluorocarbons (CFCs), 
halons, carbon tetrachloride, methyl chloroform, and hydrochlorofluorocarbons (HCFCs), are 
used in a variety of industrial applications including refrigeration and air conditioning 
equipment, aerosols, solvent cleaning, fire extinguishing, foam blowing, and sterilization.  
Although their substitutes, HFCs, are not harmful to the stratospheric ozone layer, they are 
powerful GHGs. 

Consumption of ODS Sector Worksheet 

There are no inputs required for this worksheet.  You should review this worksheet to learn 
your state’s contribution to emissions resulting from the consumption of ODS substitutes.  
The major end uses that consume substitutes for ozone-depleting substances include motor 
vehicle air conditioning, commercial and industrial refrigeration and air conditioning, 
residential refrigeration and air conditioning, aerosols, solvent cleaning, fire extinguishing 
equipment, foam production, and sterilization. 

Emissions of HFCs, PFCs, and SF6 from ODS substitute production are estimated by 
apportioning national emissions to each state based on population.  State population data 
was provided by U.S. Census Bureau (2016).  The resulting state emissions are then 
converted to metric tons of carbon dioxide equivalents (MTCO2E) as shown in Equation 13. 

Equation 13.  Emission Equation for Apportioning Emissions from the Consumption 
of Substitutes for ODS  

 
 

Step (14) Review Sector Worksheet for Semiconductor Manufacture 

Control Worksheet 

There are no emission factor inputs required for semiconductor manufacture on the control 
worksheet as the calculations for this sector are performed on the sector-specific worksheet.  
The semiconductor industry employs multiple long-lived fluorinated gases in the plasma 
etching and chemical vapor deposition processes.  These include the PFCs CF4, C2F6, and 
C3F8; HFC-23; and SF6.  With present industry growth and the increasing complexity of 
microchips, emissions from the semiconductor industry are expected to increase 
significantly.  

Semiconductor Manufacture Sector Worksheet 

There are no inputs required for this worksheet.  You should review this worksheet to learn 
your state’s contribution to emissions resulting from the manufacture of semiconductors.  
The semiconductor industry employs multiple long-lived fluorinated gases in the plasma 
etching and chemical vapor deposition processes and include PFCs CF4, C2F6, and C3F8; HFC-
23; and SF6. 

Emissions of HFCs, PFCs, and SF6 from semiconductor production are estimated by 
apportioning national emissions to each state.  National emissions are multiplied by a ratio 
of the value of a state’s semiconductor shipments, as found in U.S. Census Bureau (2002), 

Emissions (MTCO2E) =  
[National ODS Substitute Emissions (MTCO2E) × State Population]/ 

National Population 
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to the value of national semiconductor shipments.  The resulting state emissions are then 
converted into metric tons of CO2 equivalents (MTCO2E) as shown in Equation 14.  

Equation 14.  Emission Equation for Apportioning Emissions from Semiconductor 
Manufacture  

  
 

Step (15) Enter Emission Factors and Activity Data for Electric Power 
Transmission and Distribution 

Control Worksheet 

The emission factor for electric power transmission and distribution is required on the 
control worksheet.  The largest use for SF6, both domestically and internationally, is as an 
electrical insulator in electricity transmission and distribution equipment, such as gas-
insulated high-voltage circuit breakers, substations, transformers, and transmission lines.  

Electric Power Transmission and Distribution Sector Worksheet 

This worksheet requires inputs for the amount of SF6 consumed for electric power 
transmission and distribution as shown in Figure 15.  Activity data for electric transmission 
and distribution are available from U.S. EPA (2016) and EIA (2016). 

The largest use for SF6, both domestically and internationally, is as an electrical insulator in 
electricity transmission and distribution equipment, such as gas-insulated high-voltage 
circuit breakers, substations, transformers, and transmission lines.  The electric utility 
industry uses the gas because of its high dielectric strength and arc-quenching abilities.  Not 
all of the electric utilities in the United States use SF6; use of the gas is more common in 
urban areas where the space occupied by electrical distribution and transmission facilities is 
more valuable. 

Emissions from electric power transmission and distribution are calculated by multiplying 
the quantity of SF6 consumed by an emission factor.  The resulting emissions are then 
converted from metric tons of SF6 to metric tons of carbon dioxide equivalents (MTCO2E) as 
shown in Equation 15.  The default assumption is that the emission factor is 1, i.e. all SF6 

consumed is used to replace SF6 that was emitted.  Default activity data for this sector 
equals national SF6 emissions apportioned by state electricity sales divided by national 
electricity sales. 

Emissions (MTCO2E) =  
[National Semiconductor Manufacture Emissions (MTCO2E) × Value of State 

Semiconductor Shipments]/ Value of State Semiconductor Shipments 
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Equation 15.  Emission Equation for Electric Power Transmission and Distribution  

 

Figure 15.  Example of Activity Data Applied in the Electric Power Transmission 
and Distribution Worksheet 

 

Step (16) Enter Emission Factors and Activity Data for Magnesium Production 
and Processing 

Control Worksheet 

Primary and secondary production, as well as casting emission factors for magnesium 
production and processing are required in the control worksheet.  The Mg metal production 
and casting industry uses SF6 as a cover gas to prevent the violent oxidation of molten Mg 
in the presence of air.  

Magnesium Production and Processing Sector Worksheet 

In the blue input cells on the magnesium worksheet, enter the quantity of primary 
magnesium produced, secondary magnesium produced, and magnesium cast during a given 
year as shown in Figure 16.  Activity data for the production and processing of magnesium 
by state are available at USGS (2015g). 

The Mg metal production and casting industry uses SF6 as a cover gas to prevent the violent 
oxidation of molten Mg in the presence of air.  A gas mixture consisting of CO2, air, and a 
small concentration of SF6 is blown over the molten Mg metal to induce the formation of a 
protective crust.  Most producers of primary Mg metal and most Mg part casters use this 
technique.  SF6 replaced the previously used sulfur dioxide due to the numerous health and 
safety risks associated with sulfur dioxide. 

Emissions from magnesium production and processing are emitted during the production of 
primary magnesium, production of secondary magnesium, and casting of magnesium.  The 

Emissions (MTCO2E) =  
SF6 Consumption (metric tons SF6) × Emission Factor (MT SF6/MT Consumption) x 

GWP of SF6  
 

Required Data 
Input Cells 
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emissions are calculated by multiplying the quantity of primary magnesium produced, 
secondary magnesium produced, and magnesium cast during a given year by their 
respective emission factors for the same year.  The resulting emissions are then converted 
from metric tons of SF6 to metric tons of carbon dioxide equivalents (MTCO2E) as shown in 
Equation 16. 

Equation 16.  Emission Equation for Magnesium Production and Processing  

 

Figure 16.  Example of Activity Data Applied in the Magnesium Production and 
Processing Worksheet 

 
Step (17) Review Summary Information 

The steps above provide estimates of total CO2, N2O, and HFC, PFC, and SF6 emissions from 
each IP sector.  Total emissions are equal to sum of emissions from each of the fourteen IP 
sectors, for each year.  The information is collected by sector on the summary worksheets.  
There is a summary worksheet in the IP module that displays results in MMTCO2E.  
Additionally, the summary worksheet provides an overview of sources excluded from the 
current emission estimates.  Users should review this list to see if they wish to go back and 
enter data for any of the omitted IP sectors.  Figure 17 shows the summary worksheet that 
sums the emissions from all sectors in the IP module.   

Emissions (MTCO2E) =  
Quantity of Magnesium Produced (metric tons) × Emission Factor (MT 

SF6 /MT Magnesium) x GWP of SF6  
 

Required Data 
Input Cells 
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Figure 17.  Example of the Emissions Summary Worksheet in the IP Module 

 

Step (18) Export Data 

The final step is to export the summary data.  Exporting data allows the estimates from 
each module to be combined later by the Synthesis Module to produce a comprehensive 
GHG inventory for the state. 

To access the “Export Data” button, return to the control worksheet and scroll down to step 
17.  Click on the “Export Data” button and a 
message box will open that reminds the 
user to make sure all steps of the module 
have been completed.  If you make any 
changes to the IP module later, you will 
then need to re-export the results. 

Clicking “OK” prompts you to save the file.  
The file is already named, so you only need 
to choose a convenient place to save the 
file.  After the file is saved, a message box 
will appear indicating that the data was successfully exported.   

While completing the modules, you are encouraged to save each completed module; doing 
so will enable you to easily make changes without re-running it entirely. 

Following data export, the module may be reset and run for an additional state.  
Alternatively, you may run the remaining modules of the SIT to obtain a comprehensive 
profile of emissions for your state.   

Note: the resulting export file should not be 
modified.  The export file contains a summary 
worksheet that allows users to view the results, as well as 
a separate data worksheet with an unformatted version of 
the results.  The second worksheet, the data worksheet, 
contains the information that is exported to the Synthesis 
Tool.  Users may not modify that worksheet.  
Adding/removing rows, moving data, or making other 
modifications jeopardize the ability of the Synthesis 
Module to accurately analyze the data.   
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1.4 UNCERTAINTY 

In the upper right-hand corner of the Summary worksheet is a button: “Review discussion 
of uncertainty associated with these results.”  By clicking on this button, you are taken to a 
worksheet that discusses the uncertainty surrounding the activity data and emission factors, 
and how the uncertainty estimates for this source category affect the uncertainty of the 
emission estimates for your state. 
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